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Chuyên đề XV. Thu thập, xử lý ảnh vệ tinh các trận lũ lịch sử tại xã Yên Hồ 

Người thực hiện: 

Đặt vấn đề 

Hiện nay việc sử dụng ảnh viễn thám và công nghệ GIS trong tất cả các lĩnh vực là rất 

phổ biến, và việc dùng ảnh vệ tinh để giải đoán các đối tượng trên mặt đất rất thuận 

tiện thông qua các phần mền GIS. Tuy nhiên trong quá trình thực hiện chúng ta phải 

tiến hành một số thao tác nhằm chuẩn hóa các dữ liệu (như nắn chỉnh ảnh…..hiệu 

chỉnh các đường cong phổ phản xạ) 

I. NẮN CHỈNH HÌNH HỌC ẢNH 

Có nhiều nguyên nhân gây ra lỗi hình học của ảnh viễn thám, ví dụ như tốc độ bay 

chụp, độ cao bay chụp, góc nhìn của thiết bị, tốc độ gương quay, …. Những lỗi này 

có thể được khắc phục khi sử dụng một hệ thống các điểm khống chế (Ground 

Control Points - GCP) để nắn chỉnh hình học ảnh. Đây là những điểm trên bề mặt trái 

đất, đã biết tọa độ và dễ dàng nhận ra trên ảnh viễn thám. 

Bài thực hành này sẽ giúp bạn thực hiện việc nắn ảnh, sử dụng các công cụ của 

ENVI. 

1. Nắn ảnh theo ảnh đã được nắn chỉnh (Image to Image) 

 

Tiến hành theo các bước sau: 

 Bước 1: Mở ảnh đã được nắn và ảnh cần nắn, hiển thị chúng trên 2 Image khác 

nhau. 

Bước 2: Từ thanh menu chính của ENVI, bấm Map => Registration => Select GCPs: 

Image to Image => xuất hiện HT Image to Image Registration (hình 1.1). 
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Hình 1.1. HT Image to Image Registration 

Bước 3: Trong danh sách Base Image, chọn cửa sổ tương ứng với ảnh đã được nắn. 

Bước 4: Trong danh sách Warp Image, chọn cửa sổ tương ứng với ảnh cần nắn. 

Bước 5: Nhấn OK => xuất hiện HT Ground Control Points Selection cho phép chọn 

các điểm khống chế mặt đất (GCPs) (hình 1.2). 

Xác định các GCPs trên 2 ảnh thông qua các pixel nằm trên các cửa sổ Zoom. Các số 

liệu của pixel được gán vào HT Ground Control Points Selection. Các tọa độ pixel 

dạng số nguyên tương ứng với góc trên - trái của pixel. Các giá trị x,y tăng từ trái qua 

phải, từ trên xuống dưới. 

Các ký hiệu đánh dấu cho GCP được đặt tùy thuộc vào vị trí của subpixel trong cửa 

sổ Zoom. Subpixel là một phần của pixel tương ứng với hệ số phóng đại của cửa sổ 

Zoom. Ví dụ, hệ số phóng đại = 4x thì Subpixel = ¼ pixel. Các vị trí của subpixel 

giúp nâng cao độ chính xác trong việc chọn các GCPs. 
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Hình 1.2. HT Ground Control Points Selection 

 

Bước 6. Chọn các điểm GCPs như sau: 

 

+ Trong cửa sổ Image của mỗi ảnh, định vị khung Zoom trên phạm vi có điểm GCP 

mong muốn. 

+ Chọn thêm các GCPs độc lập bằng cách định vị con trỏ chuột tới cùng vị trí bề mặt 

trên cả 2 ảnh. Kiểm tra các vị trí trên 2 cửa sổ Zoom, điều chỉnh vị trí nếu cần bằng 

cách nhấn trái chuột trên mỗi cửa sổ Zoom. Các vị trí của Subpixel được hỗ trợ trên 

các cửa sổ Zoom. Các hệ số phóng đại càng lớn thì vị trí càng chính xác. 

Các tọa độ cột (sample) và hàng (line) của cả 2 ảnh xuất hiện trong HT Ground 

Control Points Selection, trong các ô Base X, Y và  Warp X, Y. Các tọa độ 

Subpixel được hiển thị ở dạng các giá trị dấu phẩy động. 

+ Trong HT Ground Control Points Selection, nhấn Add Point để thêm các GCP vào 

danh sách các GCP. 

Để xem danh sách các GCPs, nhấn Show List => xuất hiện HT Image to Image 

GCP List có chứa danh sách các GCPs đã chọn ở dạng bảng (hình 1.3). 
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Khi các GCPs được thêm vào danh sách, một ký hiệu đánh dấu được đặt trong các 

cửa sổ ảnh base và ảnh warp. Ký hiệu này chỉ ra pixel được chọn (hoặc vị trí của 

subpixel). Tâm của ký hiệu cho biết vị trí của GCP thực sự. 

+ Bổ sung các điểm GCPs theo các bước vừa nêu. Khi đã chọn được ít nhất 4 GCPs; 

các tọa độ predict x, predict y; các sai số cho x và y; sai số RMS được liệt kê trong 

bảng Image to Image GCP List. 

 

 

 

Hình 1.3. HT Image to Image GCP List 

 

Chú ý: Để có kết quả tốt, cố gắng  tối thiểu hóa RMS error. Có thể làm giảm lỗi bằng 

cách bổ sung thêm nhiều điểm GCP hơn. Nếu có ít điểm GCP thì nên chọn chúng ở 

gần với các góc ảnh hoặc phân bố chúng đều trong ảnh sẽ tốt hơn. 

Bước 7. Kiểm soát và lựa chọn các điểm GCPs 

HT Ground Control Points Selection hiển thị các điểm GCPs mà bạn đã lựa. Sau khi 

chọn được một số tối thiểu các điểm GCP đủ để kiểm soát cho phép nắn ảnh bậc 1, 

HT hiển thị các sai số ErrorX, ErrorY, RMS cho mỗi điểm GCP. 

Khung Degree trong HT Ground Control Points Selection hiển thị cấp của đa thức 

được sử dụng trong tính toán lỗi. Người sử dụng có thể thay đổi giá trị này sau khi 

đã lựa đủ số tối thiểu các điểm GCPs phù hợp cho bậc muốn đổi sang. 
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Bảng 1.1: Quan hệ giữa bậc của đa thức và số tối thiểu các điểm khống chế 

 

Phép chuyển đổi Số tối thiểu các điểm GCPs 

Affine 6 

Pseudo Affine 8 

Polynomials --------- 

Helmert 4 

Second-order Conformal 6 

Projection 8 

 

Để biết được điểm GCP có sai số RMS cao nhất, trong HT Ground Control Points 

Selection, bấm Options => Order Points by Error => Các điểm GCPs trong danh 

sách được sắp xếp lại theo trật tự: các điểm có sai số RMS giảm dần từ đầu danh sách 

đến cuối danh sách. Nếu sai số lớn vượt mức cho phép, có thể chọn điểm GCP đó, 

xóa đi và bấm chọn lại điểm. 

Bước 8. Quản lý file chứa các điểm GCPs 

Danh sách các điểm GCPs đã có trong bước 7 có thể được lưu trữ và sử dụng lại 

khi cần thiết (ví dụ để kiểm tra khi cần). 

- Để lưu thành file ASCII, ta thực hiện như sau: 

Từ menu của HT Ground Control Points Selection hoặc HT Image to Image GCP 

List, chọn File => Save GCPs to ASCII => xuất hiện HT cho phép nhập tên file có 

đuôi *.pts; nhập tên cho file.pts => bấm OK. 

- Để lưu các hệ số thành file ASCII: 

Từ  menu  của  HT  Ground  Control  Points  Selection  chọn  File  =>  Save 

Coefficients to ASCII => xuất hiện HT cho nhập tên ; nhập tên => bấm OK. 

- Sau  khi  chọn  xong  các  điểm  GCPs,  trong  HT  Ground  Control  Points 

Selection => bấm Options => Warp File => HT -> Chọn tiếp file ảnh cần nắn => HT 

Registration Parameters -> chọn phương pháp nắn ảnh (Method), phương pháp chia 
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mẫu ảnh (Resampling), chọn đường dẫn và tên file lưu ảnh kết quả (Enter Output 

FileName: ấn nút Choose) => Ấn OK. 

- Nếu muốn lưu file tọa độ các điểm GCPs, trước khi thực hiện nắn ảnh (Warp File) 

=> Từ menu của HT Ground Control Points Selection hoặc HT Image to Image 

GCP List, chọn File => Save GCPs to ASCII => xuất hiện HT cho phép nhập tên 

file có đuôi *.pts; nhập tên cho file.pts => bấm OK. 

2. Nắn ảnh theo bản đồ (Image to Map) 

Có nhiều bước tương tự như nắn Image to Image. Tiến hành theo các bước sau: 

Bước 1. Mở ảnh cần nắn và hiển thị kênh mong muốn. 

 

Bước 2. Mở file bản đồ số (định dạng Vevtor). 

 

- Từ thanh menu chính của ENVI => Vevtor => Open Vector File => xuất hiện HT 

cho phép chọn file vector đã có. ENVI hỗ trợ mở một số định dạng vector thông dụng 

của các phần mềm phổ biến như: ArcView, ArcInfo, ArcGIS, MapInfo, Microstation, 

AutoCAD, ... 

- Chọn File cần mở => ấn OK. 
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Hình 2.1. Lựa chọn phương pháp nắn ảnh theo bản đồF 

Nếu file định mở không phải là định dạng file vector của ENVI, sẽ xuất hiện HT 

yêu cầu chuyển file định mở sang định dạng của ENVI (*.evf) => lựa chọn cách lưu 

file *.evf sẽ tạo ra => ấn OK. 

- Xuất hiện HT Available Vectors List => chọn file cần mở => ấn Load 

Selected => HT lựa chọn cửa sổ hiển thị, nháy vào NewVector Layer => Cửa sổ 

hiển thị file vector xuất hiện. 

 

Hình 2.2. File dạng vector 

Bước 3. Từ thanh menu chính của ENVI, bấm Map => Registration => Select GCPs: 

Image to Map => xuất hiện HT Image to Map Registration (hình 2.3a or 2.3b). 

 



 

8 

 

 

Hình 2.2a. Chọn các tham số địa lý và hình học phù hợp 

 

 

Hình 2.2b. HT Image to Map Registration 
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HT này cho phép chọn các tham số về phép chiếu, lưới chiếu, múi chiếu, phù hợp 

với phép chiếu của bản đồ. 

Bước 4: Nếu người sử dụng mở nhiều hơn một ảnh, hãy chọn cửa sổ sẽ sử dụng từ 

danh sách Input Display của HT Image to Map Registration. Nếu chỉ mở một ảnh, nó 

sẽ được chọn tự động. 

Bước 5: Trong danh sách Select Registration Projection, chọn lưới chiếu cần nắn. 

Nếu muốn nhập một lưới chiếu do người dùng định nghĩa => ấn New. 

Bước 6: Nhấn OK => xuất hiện HT Ground Control Points Selection cho phép chọn 

các điểm khống chế mặt đất (GCPs) (hình 2.4). 

 

 

 

Hình 2.3. HT Ground Control Points Selection 

Bước 7. Chọn các điểm GCPs như sau: 

- Trong cửa sổ Image, định vị khung Zoom tới phạm vị có điểm GCP mong muốn. 

- Trong cửa sổ Zoom, kích chuột trái trên pixel có đặc điểm dễ nhận biết trên ảnh 

(cũng như trên bản đồ) để định vị con trỏ tới pixel đó hoặc Subpixel. 

Các tọa độ của vị trí được chọn sẽ xuất hiện trong HT Ground Control Points 

Selection tại ô Image X và Image Y (tọa độ ảnh). 
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- Các tọa độ thực có thể là các tọa độ đo GPS (hệ định vị toàn cầu), hoặc đọc trực tiếp 

trên bản đồ giấy và nhập trực tiếp vào HT Ground Control Points Selection, hoặc sử 

dụng công cụ phần mềm ENVI để chọn các điểm trên ảnh tương ứng với các điểm 

trên bản đồ số. Cách cuối cùng chúng ta sẽ tìm hiểu kỹ ngay sau:  

Bấm vào điểm tương ứng trên cửa sổ Vector, trên cửa sổ Vector xuất hiện một ký 

hiệu đánh dấu => Nhấn phải chuột trên cửa sổ Vector; xuất hiện menu ngữ cảnh => 

Chọn Export Map Location, tọa độ điểm đó sẽ được tự động cập nhật vào ô tọa độ 

điểm khống chế trong HT Ground Control Points Selection (tọa độ thực). 

- Chọn thêm các căp điểm GPS tương ứng trên ảnh và trên bản đồ. 

Cách phân bố các điểm GCPs vẫn tương tự như đối với nắn Image to Image, nghĩa 

là: các điểm nên phân bố đều trên toàn ảnh, nếu có ít điểm thì nên chọn gần ra phía 

góc ảnh và số điểm tối thiểu cho phương pháp nắn đã chọn theo bảng 1.1. 

-  Sau  khi  chọn  xong  các  điểm  GCPs,  trong  HT  Ground  Control  Points 

Selection => bấm Options => Warp File => HT -> Chọn tiếp file ảnh cần nắn => HT 

Registration Parameters -> chọn phương pháp nắn ảnh (Method), phương pháp chia 

mẫu ảnh (Resampling), chọn đường dẫn và tên file lưu ảnh kết quả (Enter Output 

FileName: ấn nút Choose) => Ấn OK. 

- Nếu muốn lưu file tọa độ các điểm GCPs, trước khi thực hiện nắn ảnh (Warp File) 

=> Từ menu của HT Ground Control Points Selection hoặc HT Image to Map GCP 

List, chọn File => Save GCPs to ASCII => xuất hiện HT cho phép nhập tên file có 

đuôi *.pts; nhập tên cho file.pts => bấm OK. 
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Hình 2.3a. Chọn điểm khống chế - Ground Control Point Selection 

Nói tóm lại: Trước khi muốn sử dụng các loại ảnh thì chúng ta phải tiến hành nắn 

chỉnh ảnh hình học với các phương pháp như giới thiệu trên trước khi sử dụng vào 

nhiều mục đích khác nhau. 

II: HIỆU CHỈNH ẢNH PHỔ 

1.Khái niệm viễn thám  

  Viễn thám (Remote sensing) là phương pháp công nghệ nhằm xác định thông tin về 

hình dáng, kích thước và tính chất của một vật thể, một đối tượng từ một khoảng cách 

cố định, không có sự tiếp xúc trực tiếp với chúng [10]. 
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Viễn thám là phương pháp xử lý và 

phân tích các thông tin của những đối 

tượng phân bố trên bề mặt Trái Đất và 

được thu thập từ ba tầng không gian: 

* Vũ trụ (ngoài khí quyển)  

* Tầng trung (tầng khí quyển) 

*  Mặt đất  

Nhằm xác định một cách tổng hợp 

những thuộc tính cơ bản của đối tượng 

nghiên cứu.  

 

 

Hình 2.1 Sơ đồ nguyên lý công nghệ viễn thám vệ tinh 

Cơ sở dữ liệu của viễn thám là sóng điện từ được phát xạ hoặc bức xạ từ các vật thể, 

các đối tượng trên bề mặt Trái đất. Sóng điện từ có 4 tính chất cơ bản: bước sóng, 

hướng lan truyền, biên độ và mặt phân cực. Mỗi một thuộc tính cơ bản này sẽ phản 

ánh các nội dung thông tin khác nhau của vật thể, phụ thuộc vào thành phần vật chất 

và cấu trúc của chúng, làm cho mỗi đối tượng được xác định và nhận biết một cách 

duy nhất. Sóng điện từ phản xạ hoặc bức xạ từ vật thể trên bề mặt trái đất sẽ được thu 

nhận bằng các hệ thống thu ảnh gọi là bộ cảm (sensor). Các bộ cảm được lắp đặt trên 

các phương tiện (flatform) khinh khí cầu, máy bay hoặc vệ tinh. Xử lý, phân tích, giải 

đoán (interpretation) các tấm ảnh viễn thám sẽ cho ra các thông tin về đối tượng cần 

nghiên cứu. 

Một hệ thống viễn thám khép kín bao gồm các phương tiện bay chụp, trung tâm điều 

khiển mặt đất, trung tâm xử lý, trung tâm hành chính, trung tâm khai thác tư liệu và 

ứng dụng. 

Hiện nay, viễn thám đang được ứng dụng nhiều trong việc giám sát tài nguyên môi 

trường. Ở các phần sau, ta sẽ đi tìm hiểu sâu hơn về tư liệu viễn thám để biết được 

những khả năng của nó phục vụ cho đề tài ra sao. 

1.1. Đặc tính cơ bản của tư liệu viễn thám 
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Dữ liệu viễn thám bao gồm dữ liệu ảnh hàng không và dữ liệu ảnh vệ tinh. Viễn thám 

vệ tinh sử dụng các bộ cảm gắn trên vệ tinh nhân tạo hoạt động ở nhiều bước sóng từ 

400nm-25cm để thu dữ liệu về các đối tượng nghiên cứu trên Trái Đất. Trong luận 

văn, học viên đã sử dụng các ảnh Landsat, SPOT là các ảnh được thu trong dải sóng 

nhìn thấy và cận hồng ngoại. Các thông số quan trọng nhất đặc trưng cho thông tin 

của một ảnh vệ tinh cần được lựa chọn cho đối tượng nghiên cứu, đó là độ phân giải 

không gian, độ phân giải phổ, độ phân giải thời gian, độ phân giải bức xạ. 

- Độ phân giải không gian: Độ phân giải không gian của ảnh vệ tinh, do đặc tính của 

đầu thu, phụ thuộc vào trường nhìn tức thì (IFOV) được thiết kế sẵn. Ý nghĩa quan 

trọng nhất của độ phân giải không gian là nó cho biết đối tượng nhỏ nhất mà có thể 

phân biệt trên ảnh.  

- Độ phân giải phổ: Vệ tinh thu nhận sóng phản xạ trên một khoảng bước sóng nhất 

định. Độ rộng hẹp của khoảng bước sóng này là độ phân giải phổ của ảnh. Khoảng 

bước sóng càng hẹp thì tính chất phản xạ phổ của đối tượng càng đồng nhất. 

- Độ phân giải thời gian: Vệ tinh viễn thám chuyển động trên quỹ đạo và chụp ảnh 

Trái Đất. Sau một khoảng thời gian nhất định, nó quay lại và chụp lại vùng đã chụp. 

Khoảng thời gian này gọi là độ phân giải thời gian của vệ tinh. Với khoảng thời gian 

lặp lại càng nhỏ thì thông tin thu thập càng nhiều. 

- Độ phân giải bức xạ (radiometric resolution): là khả năng lượng tử hóa thông tin bức 

xạ của các đôi tượng được các bộ cảm lượng tử dưới dạng đơn vị thông tin trong dữ 

liệu (ví dụ ảnh 8 bit, 9 bit, 16 bit...)  

Ngoài ra, số lượng kênh ảnh cũng là một yếu tố quan trọng ảnh hưởng đến thông tin 

thu nhận trên ảnh viễn thám. Ảnh được thu càng nhiều kênh thì càng có nhiều thông 

tin về đối tượng thu được. Các ảnh đa phổ thông thường thu được từ 3-10 kênh. 

Khả năng nhận biết đối tượng trên ảnh vệ tinh phụ thuộc vào độ phân giải. Căn cứ vào 

độ phân giải không gian của ảnh, ta có thể chia ra thành 4 mức dữ liệu ảnh viễn thám:  

- Dữ liệu có độ phân giải thấp như ảnh NOAA, MODIS, MERIS... 

- Dữ liệu có độ phân giải trung bình như ảnh Landsat MSS (80m)…  

- Dữ liệu có độ phân giải cao như Landsat TM (30m, 15m), SPOT (20m, 10m…) 

Aster (15m) … 
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- Dữ liệu có độ phân giải siêu cao như IKONOS (1-5m), Quickbird (1m), obview… 

Để lựa chọn tư liệu viễn thám phù hợp cho khu vực và đối tượng nghiên cứu, cần thiết 

phải xem xét và cân nhắc giữa các độ phân giải. Nghiên cứu đô thị cần có độ phân giải 

không gian từ trung bình tới cao và siêu cao do đặc tính của đô thị là không đồng nhất.  

1.2. Đặc tính phản xạ phổ của các đối tượng tự nhiên 

Đồ thị phản xạ phổ được xây dựng với chức năng là một hàm số của giá trị phổ phản 

xạ và bước sóng, được gọi là đường cong phổ phản xạ. Hình dáng của đường cong 

phổ phản xạ cho biết một cách tương đối rõ ràng tính chất phổ của một đối tượng và 

hình dạng đường cong phụ thuộc rất nhiều vào việc lựa chọn các dải sóng mà ở đó 

thiết bị viễn thám có thể ghi nhận được các tín hiệu phổ. 

Hình dạng của đường cong phổ phản xạ còn phụ thuộc rất nhiều vào tính chất của các 

đối tượng. Trong thực tế, các giá trị phổ của các đối tượng khác nhau, của một nhóm 

đối tượng cũng rất khác nhau, song về cơ bản chúng dao động quanh giá trị trung 

bình. 

Nguyên tắc cơ bản để phân biệt các đối tượng lớp phủ mặt đất trên ảnh vệ tinh là dựa 

vào sự khác biệt về đặc tính phản xạ của chúng trên các kênh phổ. Hình 1.2 dưới đây 

thể hiện đặc tính phản xạ của các thành phần đất, nước và thực vật trên ảnh vệ tinh. 

 

Hình 2.2: Đặc tính phản xạ phổ của đất, nước và thực vật trên ảnh vệ tinh 

Đặc tính phản xạ phổ của thực vật 

Thực vật khỏe mạnh chứa nhiều diệp lục tố (Chlorophil), phản xạ rất mạnh ánh sáng 

có bước sóng từ 0,45 – 0,67µm (tương ứng với dải sóng màu lục – Green) vì vậy ta 

nhìn thấy chúng có màu xanh lục. Khi diệp lục tố giảm đi, thực vật chuyển sang có 

khả năng phản xạ ánh sáng màu đỏ trội hơn. Kết quả là lá cây có màu vàng (do tổ hợp 

Hångngo¹ i gÇn Hångngo¹ i trung

d¶I sãng
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§ Êt ­ í t

Thùc vËt
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màu green và red) hoặc màu đỏ hẳn (rừng ở khí hậu lạnh, hiện tượng này khá phổ biến 

khi mùa đông đến), ở vùng hồng ngoại phản xạ (từ 0,7 – 1,3µm) thực vật có khả năng 

phản xạ rất mạnh, khi sang vùng hồng ngoại nhiệt và vi sóng (microwave) một số 

điểm cực trị ở vùng sóng dài làm tăng khả năng hấp thụ ánh sáng của hơi nước trong 

lá, khả năng phản xạ của chúng giảm đi rõ rệt và ngược lại, khả năng hấp thụ ánh sáng 

lại tăng lên. Đặc biệt, đối với rừng có nhiều tầng lá, khả năng đó càng tăng lên. 

Đặc tính phản xạ phổ của nước 

Nước không chỉ phản xạ mạnh ở vùng sóng của tia xanh lơ (Blue) và yếu dần khi sang 

vùng tia xanh lục (Green), triệt tiêu ở cuối dải sóng đỏ (Red). Khi nước bị đục, khả 

năng phản xạ tăng lên do ảnh hưởng sự tán xạ của các vật chất lơ lửng. Sự thay đổi về 

tính chất của nước (độ đục, độ sâu, hàm lượng Chlorophil...) đều ảnh hưởng đến tiính 

chất phổ của chúng. Nghĩa là khi tính chất nước thay đổi, hình dạng đường cong và 

giá trị phổ phản xạ sẽ bị thay đổi. Ngoài ra nó còn phụ thuộc vào bề mặt và trạng thái 

của nước. Trên kênh hồng ngoại và cận hồng ngoại đường bờ nước được phát hiện rất 

dễ dàng. 

Đặc tính phản xạ phổ của đất khô 

Đường cong phản xạ phổ của đất khô tương đối đơn giản, ít có những cực đại và cực 

tiểu một cách rõ ràng, lý do chính là các yếu tố ảnh hưởng đến tính chất phổ của đất 

khá phức tạp và không rõ ràng như ở thực vật. 

Các yếu tố ảnh hưởng đến đường cong phổ phản xạ của đất là : lượng ẩm, cấu trúc của 

đất (tỉ lệ cát, bột và sét), độ nhám bề mặt, sự có mặt của các loại oxyt kim loại, hàm 

lượng vật chất hữu cơ,...các yếu tố đó làm cho đường cong phổ phản xạ biến động rất 

nhiều quanh đường cong có giá trị trung bình. Tuy nhiên quy luật chung là giá trị phổ 

phản xạ của đất tăng dần về phía sóng có bước sóng dài. Các cực trị hấp thụ phổ do 

hơi nước cũng diễn ra ở vùng 1,4 ; 1,9 và 2,7µm. 

Bên cạnh các đặc trưng phản xạ phổ của các đối tượng tự nhiên cơ bản, Root và Mille 

nghiên cứu và đưa ra các đặc trưng phản xạ phổ của một số đối tượng chính trong đô 

thị như bê tông, ván lợp, nhựa đường và đất trống (hình 2.3). Các đặc trưng này là 

thông tin quan trọng giúp quá trình giải đoán các đối tượng đô thị 
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Hình 2.3. Đặc tính phản xạ phổ các đối tượng trong đô thị 

Tóm lại, phổ phản xạ là thông tin quan trọng nhất mà viễn thám thu được về các đối 

tượng. Dựa vào đặc điểm phổ phản xạ (cường độ, dạng đường cong ở các dải sóng 

khác nhau) có thể phân tích, so sánh và nhận diện các đối tượng trên bề mặt.  

1.3. Hiệu chỉnh phổ 

Hiệu chỉnh phổ là công việc rất quan trọng trong việc giải đoán các đối tượng 

Như đã thấy ở trên, không phải toàn bộ giải sóng điện từ được sử dụng trong việc thu 

nhận ảnh viễn thám. Thông thường, tuỳ thuộc vào mục đích thu thập thông tin, mỗi 

loại đầu thu được thiết kế để có thể thu nhận sóng điện từ trong một số khoảng bước 

sóng nhất định. Các khoảng bước sóng này được gọi là các kênh ảnh.  

Ta cũng thấy ở trên, bức xạ phổ (bao gồm cả phản xạ, tán xạ và bức xạ riêng) của một 

đối tượng thay đổi theo bước sóng điện từ. Như vậy, ảnh chụp đối tượng trên các kênh 

khác nhau sẽ khác nhau. Điều này có nghĩa là ảnh được thu trên càng nhiều kênh thì 

càng có nhiều thông tin về đối tượng được thu thập. Số lượng kênh ảnh được gọi là độ 

phân giải phổ. Độ phân giải phổ càng cao (càng nhiều kênh ảnh) thì thông tin thu thập 

từ đối tượng càng nhiều. Và đương nhiên giá thành càng lớn. Vì vậy tùy theo mục đích 

sử dụng nên kết hợp nhiều loại ảnh ở các độ phân giải khác nhau để nghiên cứu một 

khu vực. Thông thường, các vệ tinh đa phổ thường có số kênh ảnh từ khoảng 3 đến 10 

kênh. Hiện nay, trong viễn thám đa phổ,  các loại vệ tinh viễn thám có khả năng thu 

được rất nhiều kênh ảnh (trên 30 kênh) gọi là các vệ tinh siêu phổ (hyperspectral 

satellite) đang được phát triển. Khi xem xét độ phân giải để chọn ảnh cần tuân thủ luật 

cơ bản: chọn độ phân giải gấp 10 lần kích cỡ của đối tượng muốn nghiên cứu. Nhưng 
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nên nhớ rằng không phải luật cơ bản lúc nào cũng đúng, cần phải xem xét cả các đặc 

điểm khác của đối tượng như tính tương phản, vị trí, hình dạng. 

 

Hình 2.5a. Độ phân giải phổ 

 

Hình 2.5b. Độ phân giải thời gian 

Tóm lại, thông tin trên ảnh viễn thám quang học là phản xạ phổ của các đối tượng trên 

mặt đất, bao gồm lớp phủ thực vật, nước và đất trống được ghi nhận thành từng pixel 

ảnh có độ phân giải không gian xác định, trên nhiều kênh phổ xác định và vào một 

thời gian xác định.  
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Như vậy: Chúng ta phải tiến hành điều chỉnh các đường cong phản xạ phổ sao cho 

người giải đoán có thể phân biệt các đối tượng một cách dễ dàng. 

III: GIẢI ĐOÁN VẾT LŨ VÀ THỰC ĐỊA KIỂM TRA 

Giải đoán vết lũ  

Bản đồ nguy cơ ngập lụt là tài liệu cơ bản, làm cơ sê khoa học cho việc quy hoạch 

phòng tránh lũ lụt, lựa chọn các biện pháp, thiết kế các công trình khống chế lũ, 

là thông tin cần thiết để thông báo cho nhân dân về nguy cơ thiệt hại do lũ lụt ê 

nơi học cư trú và hoạt động. 

(Bản đồ ngập lụt thường thể hiện các nội dung sau) 

♦  Vùng úng ngập thường xuyên. 

♦  Vùng ngập lụt ứng với tần suất mưa, lũ khác nhau. 

♦  Khu vực nguy hiểm khi có lũ lớn. 

♦  Khu vực có nguy cơ bị trượt lê, sạt lê. 

♦  Vết xói lê bờ sông, sạt lê bờ biển, trượt lê sườn. 

Bản đồ ngập lụt phải xác định rõ ranh giới những vùng bị ngập do một trận mưa 

lũ nào đố gây ra trên bản đồ. Ranh giới vùng ngập lụt phụ thuộc vào các yếu tố 

mực nước lũ và địa hình, địa mạo của khu vực đó; trong khi nhân tố địa hình ít 

thay đổi nên ranh giới ngập lụt chỉ còn phụ thuộc vào sự thay đổi mực nước lũ. 

[2, 3]. 

Giải đoán vết lũ dựa vào việc mô phỏng bằng các mô hình thủy văn, thủy lực 

Sử dụng công cụ mô phỏng, mô hình hóa bằng các mô hình thủy văn, thủy lực là rất 

cần thiết và có hiệu quả hơn rất nhiều và cũng là cách tiếp cận hiện đại và đang được 

sử dụng rộng rãi trong thời gian gần đây trên cả thế giới và ở Việt Nam trong sự kết 

hợp với cả các lợi thế của phương pháp truyền thống. 
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Mặt khác, với sự phát triển của máy tính và các hệ thống thông tin, cơ sở dữ liệu ngày 

càng có nhiều ứng dụng phát triển dựa trên nền hệ thông tin địa lý (GIS), mà xây dựng 

bản đồ ngập lụt là một trong những ứng dụng quan trọng mang lại nhiều lợi ích thiết 

thực trong thực tiễn công tác phòng chống lụt bão và giảm nhẹ thiên tai. 

Tổng quan về các mô hình thủy văn, thủy lực giải đoán vết lũ 

Các mô hình mưa dòng chảy 

■ Mô hình Ltank: do PGS.TS Nguyễn Văn Lai đề xuất năm 1986, là một 

phiên bản cải tiến từ mô hình Tank gốc của tác giả Sugawara (1959). Mô hình 

toán mưa rào dòng chảy dựa trên quá trình trao đổi lượng ẩm giữa các tầng mặt, 

ngầm lưu vực, và bốc hơi. Ứng dụng tốt cho lưu vực vừa và nhỏ. 

■ Mô hình HEC-HMS: là mô hình mưa dòng chảy của trung tâm thủy văn 

kỹ thuật quân đội Hoa Kỳ được phát triển từ mô hình HEC-1, mô hình có những 

cải tiến đáng kể cả về kỹ thuật tính toán và khoa học thủy văn thích hợp với các 

lưu vực sông vừa và nhỏ. Là dạng mô hình tính toán thủy văn được dùng để tính 

dòng chảy từ số liệu đo mưa trên lưu vực. Trong đó các thành phần mô tả lưu 

vực sông gồm các công trình thủy lợi, các nhánh sông. 

Kết quả của HEC-HMS được biểu diễn dưới dạng sơ đồ, biểu bảng tường minh 

rất thuận tiện cho người sử dụng. Ngoài ra, chương trình có thể liên kết với cơ sở 

dữ liệu dạng DSS của mô hình thủy lực HEC-RAS. 

Mô hình NAM: được xây dựng năm 1982 tại khoa thủy văn viện kỹ thuật thủy 

động lực và thủy lực thuộc đại học kỹ thuật Đan Mạch. Mô hình dựa trên nguyên 

tắc các bể chứa theo chiều thẳng đứng và hồ chứa tuyến tính. Mô hình tính quá 

trình mưa - dòng chảy theo cách tính liên tục hàm lượng ẩm trong năm bể chứa 

riêng biệt tương tác lẫn nhau. NAM mô phỏng quá trình mưa - dòng chảy bằng 

việc mô tả liên tục cho các thành phần trong 4 vùng trữ lượng tương tác lẫn nhau 

bao gồm: trữ lượng tuyết; Trữ lượng nước mặt; Trữ lượng nước sát mặt; Trữ 

lượng nước ngầm. 

Các mô hình thủy văn trên đây cho kết quả là các quá trình dòng chảy tại các 

điểm khống chế (cửa ra lưu vực) vì vậy tự thân chúng đứng độc lập chưa đủ khả 

năng để đưa ra các thông tin về diện tích và mức độ ngập lụt mà phải kết hợp cới 

một số các công cụ khác như GIS, hoặc là biên cho các mô hình thủy động lực 1-2 

chiều khác. [3] 
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Mô hình Thủy lực 

Mô hình VRSAP (Vietnam River System And Plains): tiền thân là mô hình KRSAL 

do cố PSG.TS Nguyễn Như Khuê xây dựng từ 1965 đến 1993 đang được sử dụng 

rộng rãi ở nước ta. 

Đây là mô hình toán thủy văn - thủy lực của dòng chảy một chiều trên hệ thống sông 

ngòi có nối với đồng ruộng và các khu chứa khác. Dòng chảy trong các đoạn sông 

được mô tả bằng hệ phương trình Saint-Venant đầy đủ, không bỏ bớt một vài số hạng 

như trong một số mô hình khác. Dòng chảy qua các công trình được mô tả bằng các 

công thức thủy lực đã biết và được đưa vào cùng một số hạng như phương trình của 

các đoạn sông. Dòng chảy tràn vào các ô ruộng hay khu chứa được mô phỏng theo tư 

tưởng chung của mô hình SOGREAH. Các khu chứa nước và các ô đồng ruộng trao 

đổi nước với sông và trao đổi nước với nhau qua các tràn hay cống điều tiết. Do đó, 

mô hình đã chia các khu chứa và các ô đồng ruộng thành hai loại chính. Loại kín trao 

đổi nước với sông qua cống điều tiết, loại hở trao đổi nước với sông qua tràn mặt hay 

trực tiếp gắn với sông như các khu chứa thông thường. 

Mô hình VRSAP cũng xét đến sự gia nhập của mưa trong tính toán thủy lực dòng 

chảy trong các hệ thống sông khi diễn toán lũ hay tính tiêu nước cho hệ thống thủy 

nông. Mô hình cũng xét đến khả năng truyền mặn trên hệ thống sông và đồng ruộng. 

Sơ đồ tính trong VRSAP là sơ đồ sai phân ẩn lưới chữ nhật có xét đến trọng số đối với 

các bước sai phân theo thời gian t và không gian x. 

Mô hình VRSAP phù hợp với điều kiện Việt Nam, có thể sử dụng để: 

+ Tính toán và tìm ra quy luật thay đổi của lưu lượng Q và mực nước Z tại từng mặt 

cắt trên hệ thống sông và ô chứa kể cả vùng bị ảnh hưêng của thủy triều. 

+ Giải bài toán tiêu úng, thoát lũ và cấp nước trên các hệ thống công trình thủy lợi 

vùng đồng bằng và ven biển. 

+ Lập các phương án quy hoạch quản lý và khai thác thủy lợi trên lưu vực sông lớn 

nhỏ và các hệ thống công trình thủy lợi. 

+ Tính truyền triều và truyền mặn trên các hệ thống sông v.v... 

Mô hình VRSAP là mô hình mã nguồn mê, nên từ đó nhiều tác giả đã cải tiến để mô 

hình có thể tính được truyền tải phù sa, tính tiêu thoát nước đô thị. Các loại mô hình 

toán này hiện cũng đang được ứng dụng ê nước ta và cho kết quả tốt. Một số ứng 
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dụng của mô hình cho hệ thống sông Hồng, sông Thái Bình, sông Cả, sông Nhật Lệ, 

sông Hương, sông Thu Bồn, sông Cửu Long……đủ  đạt các kết  quả tin cậy. 

 Mô hình VRSAP ứng dụng rất có hiệu quả đối với việc tính  toán thủy lực tưới tiêu, 

các hệ thống thủy nông, quy hoạch và lập các dự án quản lý, khai thác hệ thống thủy 

nông, tính toán quy mô các công trình trên hệ thống, quản lý lưu vực và tài nguyên. 

■ Họ mô hình MIKE: do viện thủy lực Đan Mạch (DHI) xây dựng được tích hợp 

rất nhiều các công cụ mạnh, có thể giải quyết các bài toán cơ bản trong lĩnh vực tài 

nguyên nước. Tuy nhiên đây là mô hình thương mại, phí bản quyền rất cao nên không 

phải cơ quan nào cũng có điều kiện sử dụng. 

♦ MIKE 11: là mô hình một chiều trên kênh hê, bãi ven sông, vùng ngập lũ, trên 

sông kênh có kết hợp mô phỏng các ô ruộng mà kết quả thủy lực trong các ô ruộng là 

“giả hai chiều”. MIKE 11 có một số ưu điểm nổi trội so với các mô hình như: 

i. Liên kết với GIS; 

ii. Kết nối với các mô hình thành phần khác của bộ MIKE ví dụ mô hình mưa rào. 

- dòng chảy NAM, mô hình thủy động lực học 2 chiều MIKE 21, mô hình dòng 

chảy nước dưới đất, dòng chảy tràn bề mặt và dòng bốc thoát hơi thảm phủ (MIKE 

SHE); 

iii. Tính toán chuyển tải chất khuyếch tán; 

iv. Vận hành công trình; 

v. Tính toán quá trình phú dưỡng; 

Hệ phương trình sử dụng trong mô hình là hệ phương trình Saint - Venant một chiều 

không gian, với mục đích tìm quy luật diễn biến của mực nước và lưu lượng dọc theo 

chiều dài sông hoặc kênh dẫn và theo thời gian. 

Mô hình MIKE 11 đã được ứng dụng rộng rãi tại Việt Nam và trên phạm vi toàn thế 

giới. Tuy nhiên MIKE 11 không có khả năng mô phỏng tràn bãi nên trong các bài toán 

ngập lụt MIKE 11 chưa mô phỏng một cách đầy đủ quá trình nước dâng từ sông vào 

tràn bãi vào ruộng và ngược lại để cái thiện vấn đề này bộ MIKE có thêm mô hình 

thủy lực hai chiều MIKE 21 và bộ kết nối MIKE FLOOD. 
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♦ MIKE 21 & MIKE FL00D: là mô hình thủy động lực học dòng chảy 2 chiều 

trên vùng ngập lũ đã được ứng dụng tính toán rộng rãi tại Việt Nam và trên phạm vi 

toàn thế giới. Mô hình MIKE 21 HD là mô hình thủy động lực học mô phỏng mực 

nước và dòng chảy trên sông, vùng cửa sông vịnh và ven biển. Mô hình mô phỏng 

dòng chảy không ổn định hai chiều ngang đối với một lớp dòng chảy. 

Mike 21 HD có thể mô hình hóa dòng chảy tràn với nhiều điều kiện được tính đến, 

gao gồm: 

i. Ngập và tiêu nước cho vùng tràn 

ii. Tràn bờ 

iii. Dòng chảy qua công trình thủy lợi 

iv. Thủy triều 

v. Nước dâng do mưa bão 

Phương pháp mô phỏng bao gồm phương trình liên tục kết hợp với phương trình động 

lượng mô tả sự biến đổi của mực nước và lưu lượng. Lưới tính toán sử dụng trong mô 

hình là lưới hình chữ nhật. 

Tuy nhiên MIKE 21 nếu độc lập cũng khó có thể mô phỏng tốt quá trình ngập lụt tại 

một lưu vực sông với các điều kiện ngập thấp. Để có thể tận dụng tốt các ưu điểm và 

hạn chế những khuyết điểm của cả hai mô hình một chiều và hai chiều trên, DHI đã 

cho ra đời một công cụ nhằm tích hợp cả hai mô hình trên; đó là công cụ MIKE 

FLOOD. 

MIKE FLOOD là một công cụ tổng hợp cho việc nghiên cứu các ứng dụng về vùng 

bãi tràn và các nghiên cứu về dâng nước do mưa bão. Ngoài ra, MIKE FLOOD còn có 

thể nghiên cứu về tiêu thoát nước đô thị, các hiện tượng vỡ đập, thiết kế công trình 

thủy lợi và tính toán cho các vùng sông lớn. 

MIKE FLOOD được sử dụng khi cần có sự mô tả hai chiều ở một số khu vực (MIKE 

21) và tại những nơi cần kết hợp mô hình một chiều (MIKE 11). Trường hợp cần kết 

nối một chiều và hai chiều là khi cần có một mô hình vận tốc chi tiết cục bộ (MIKE 

21) trong khi thay đổi dòng chảy sông được điều tiết bởi các công trình phức tạp (cửa 

van, cống điều tiết, các công trình thủy lợi đặc biệt...) mô phỏng theo mô hình MIKE 
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11. Khi đó mô hình một chiều MIKE 11 có thể cung cấp điều kiện biên cho mô hình 

MIKE 21 và ngược lại. 

■ Bộ mô hình MIKE 11 và MIKE 11-GIS của viện thủy lực đan mạch (DHI) sử 

dụng để xây dựng bản đồ ngập lụt cho vùng hạ lưu sông. MIKE 11-GIS là bộ công cụ 

mạnh trong trình bày và biểu diễn về mặt không gian và thích hợp công nghệ mô hình 

bãi ngập và sông của MIKE 11 cùng với khả năng phân tích không gian của hệ thông 

tin địa lý trên môi trường ARCGIS 9.1. 

MIKE 11-GIS có thể mô phỏng diện ngập lớn nhất, nhỏ nhất hay diễn biến từ lúc 

nước lên cho tới lúc nước xuống trong một trận lũ. Độ chính xác của kết quả tính từ 

mô hình và thời gian tính toán phụ thuộc rất nhiều vào độ chính xác của DEM. Nó cho 

biết diện ngập và độ sâu tương ứng từng vùng nhưng không xác định được hướng 

dòng chảy trên đó. 

■ Mô hình MIKE SHE: mô hình toán vật lý thông số phân bổ mô phỏng hệ thống 

tổng hợp dòng chảy mặt, dòng chảy ngầm lưu vực sông. Mô phỏng biến đổi về lượng 

và chất hệ thống tài nguyên nước. Bao gồm dòng chảy trong lòng dẫn, dòng chảy tràn 

bề mặt, dòng chảy ngầm tầng không áp, dòng chảy ngầm tầng có áp, dòng chảy tầng 

ngầm chuyển tiếp giữa tầng có áp và tầng không áp, bốc thoát hơi từ tầng thảm phủ, 

truyền chất, vận chuyển bùn cát. Ứng dụng thực tiễn: đã được ứng dụng tính toán rộng 

rãi trên phạm vi toàn thế giới. Ở Việt Nam MIKE SHE được ứng dụng mô phỏng 

dòng hệ thống dòng chảy ngầm, mặt lưu vực. 

Qua thực tế việc sử dụng các mô hình thủy văn, thủy lực hiện nay trên thế giới và tại 

Việt Nam; với mong muốn mô phỏng một cách chính xác nhất quá trình ngập lụt 

trong khu vực nghiên cứu, tác giả nhận thấy bộ mô hình MIKE-FLOOD của Viện 

thủy lực Hà Lan có thể đáp ứng được yêu cầu xây dựng bản đồ ngập lụt cho khu vực 

nghiên cứu với các lý do sau: 

♦ Bộ mô hình MIKE bao gồm: mô hình thủy văn MIKE NAM, dùng để tính toán 

các biên đầu vào cho mô hình thủy lực 1 chiều MIKE 11, cũng như biên gia nhập khu 

giữa cho mô hình thủy lực hai chiều MIKE 21. Mô hình thủy lực một chiều MIKE 11 

mô phỏng dòng chảy một chiều trong sông và mô hình hai chiều MIKE 21 mô phỏng 

dòng chảy hai chiều ngang bãi tràn. Bộ mô hình này rất phù hợp để mô phỏng ngập 

lụt ở hạ lưu lưu vực sông Ba nơi thường xuyên xảy ra các trận lũ từ nhở đến lớn. 
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♦ Điều kiện số liệu đo đạc trong khu vực hạn chế do nhiều nguyên nhân khác 

nhau nên việc sử dụng mô hình MIKE-NAM để tính toán dòng chảy từ mưa làm biên 

đầu vào cho mô hình thủy lực là cần thiết. 

♦ Mô hình MIKE FLOOD là một công cụ tổng hợp cho việc nghiên cứu các ứng 

dụng về vùng bãi tràn phù hợp cho vùng trũng nghiên cứu, có thể thể hiện được cả 

mức độ ngập lụt lẫn tốc độ và hướng dòng chảy lũ trong vùng ngập lụt. 

♦ Mô hình EFDC 

Mô hình EFDC (Environmental Fluid Dynamics Code) là một phần mềm mô hình 

toán có khả năng dự báo, tính toán và mô phỏng các quá trình dòng chảy, lan truyền 

có tính đến các quá trình sinh - địa - hóa trong sông, hồ, hồ chứa, các vùng cửa sông. 

Mô hình được cơ quan bảo vệ môi trường Mỹ US EPA phát triển từ những năm 1980 

đến 1994 được các nhà khoa học viện khoa học biển Virgina tiếp tục xây dựng. Mô 

hình được xây dựng dựa trên các phương trình động lực, nguyên tắc bảo toàn khối 

lượng và bảo toàn thể tích. Mô hình là mô hình đa chiều (1 chiều, 2 chiều, 3 chiều) 

nên có khả năng đạt độ chính xác cao trong việc mô hình hóa các hệ thống đầm lầy, 

đất ngập nước, kiểm soát dòng chảy, các dòng sinh song gần bờ và các quá trình vận 

chuyển trầm tích. [2] 

Thực địa kiểm tra 

Tiến hành đo đạc thực địa 

Tiến hành đo đạc thực địa bằng máy đo cao tần các vết lũ hàng năm ví dụ như (hình 

2.1). Đây là cách thực hiện thực địa với các vết tích lũ để lại cộng với hỏi người dân 

sinh sống ở khu vực này. 
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Hình 2.1. Sơ đồ thực địa đo các vết lũ hàng năm ở khu vực 

KẾT LUẬN 

Khi tiến hành sử dụng ảnh thu được thông qua việc doawnload ảnh (Spot, Lansad….) 

từ vệ tinh, do tính chất và hình dạng của quả địa cầu, nên chúng thường bị lệch so với 

mặt phẳng ngang một góc nhất định, vì vậy chúng ta phải thực hiện nắn chỉnh ảnh 

hình học cho nó sao cho khớp với khu vực nghiên cứu (Hệ tọa độ, lưới chiếu). 

Khi tiến hành giải đoán phổ cho các đối tượng thường không chính xác, có nhiều 

nguyên nhân (chủ quan, khách quan), do vậy trong quá trình này chúng ta phải hiệu 

chỉnh phổ sao cho người giải đoán có thể phân biệt rõ ràng các đối tượng bằng cách 

chúng ta hiệu chỉnh các đường cong phổ phản xạ. 

Giải đoán vết lũ thông qua các phương pháp mô hình ngập lụt cộng với việc điều tra 

thực địa hiện nay đang được sử dụng rất nhiều ở nước ta. Thông qua việc giải đoán 

các vết lũ trên ảnh viễn thám. 
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